10 Setting up your resources .................................................................56
  10.1 Using the Setup wizard .................................................................56
  10.2 Manual setup using Resources window .......................................56

11 Constructing an observing plan .......................................................81
  11.1 Manual construction .................................................................81
  11.2 User-contributed plans .............................................................90
  11.3 Plan Creation Wizard ...............................................................90
  11.4 Editing objects ..........................................................................94
  11.5 Importing objects from other sources ......................................95

12 Plan document window ....................................................................96
  12.1 Common information and settings ............................................96
  12.2 Objects tab ................................................................................100
  12.3 Observations tab .......................................................................119
  12.4 Field of View tab ......................................................................128
  12.5 Sky tab ......................................................................................150
  12.6 Object list functions ..................................................................164
  12.7 Field of View functions ............................................................182

13 Observations ..................................................................................185
  13.1 Logging observations ...............................................................185
  13.2 Observation database ...............................................................186

14 Controlling a computerised telescope ...........................................199
  14.1 Choosing a mount type ............................................................199
  14.2 Configuration ...........................................................................201
  14.3 ASCOM configuration ..............................................................205
  14.4 Connecting & disconnecting .....................................................207
  14.5 Slewing .....................................................................................207
  14.6 Syncing .....................................................................................207
  14.7 Tracking ....................................................................................208
  14.8 Control palette ..........................................................................208
  14.9 High-precision slewing ............................................................212
  14.10 Spiral Scan ................................................................................214
  14.11 Emulated mounts ....................................................................215
  14.12 Other features .........................................................................215
  14.13 Vendor-specific features .........................................................219

15 Telescope alignment ........................................................................223
  15.1 Iterative polar alignment ..........................................................223
  15.2 Polar drift alignment ..................................................................224
  15.3 Polar alignment scope tool .........................................................226
  15.4 1-star polar alignment ...............................................................226
16 Printing ........................................................................................................... 228
  16.1 Sky and Field of View Charts ................................................................. 228
  16.2 Objects .................................................................................................... 228
  16.3 Objects & observations .......................................................................... 232
  16.4 Observing forms .................................................................................... 234
  16.5 Finder charts .......................................................................................... 237
  16.6 Observing sessions & observations ....................................................... 246

17 Journal ........................................................................................................ 256

18 Downloading and using sky images ......................................................... 258
  18.1 Downloading .......................................................................................... 260
  18.2 Object list ............................................................................................... 263
  18.3 Field of View chart .............................................................................. 266
  18.4 Images window ..................................................................................... 267
  18.5 Image Manager ...................................................................................... 269

19 Highlighting & associating list objects ..................................................... 275
  19.1 Highlighting objects ............................................................................. 275
  19.2 Associating objects ................................................................................ 279

20 User-defined fields .................................................................................... 280
  20.1 Field values vs. field definitions ........................................................... 280
  20.2 Field types ............................................................................................. 280
  20.3 Creating and editing a user-defined field .............................................. 281
  20.4 Deleting a user-defined field & values .................................................. 288
  20.5 Object list user-defined fields ............................................................... 288

21 Preferences ............................................................................................... 289
  21.1 General preferences ............................................................................ 289
  21.2 Printing preferences ............................................................................ 292
  21.3 Web preferences ................................................................................... 294
  21.4 External applications preferences ....................................................... 295
  21.5 Object list preferences ........................................................................ 296
  21.6 Field of View chart preferences ........................................................... 303
  21.7 Sky chart preferences .......................................................................... 309
  21.8 Catalogue preferences ......................................................................... 310
  21.9 Observation preferences ..................................................................... 312
  21.10 Image preferences ............................................................................. 316
  21.11 Scripting preferences ......................................................................... 320
  21.12 Other preferences .............................................................................. 323

22 Communicating with other applications .................................................. 325
  22.1 Importing & exporting data ................................................................... 325
  22.2 Direct control ......................................................................................... 325

23 User-contributed observing plans ............................................................ 326
  23.1 Downloading plans ............................................................................... 326
  23.2 Uploading a plan ................................................................................... 327
  23.3 Deleting a plan ...................................................................................... 328

- iii -
24 Managing catalogues .................................................................329
  24.1 Using the Setup Wizard..........................................................329
  24.2 Installing, updating and removing catalogues..........................330
  24.3 Catalogue settings and coverage ............................................332
  24.4 Catalogue Types & IDs ..........................................................334
  24.5 Plan Creation Wizard catalogues ............................................335
  24.6 Displaying catalogue contents ..............................................336
  24.7 Catalogue annotations .........................................................338

25 Comets & Minor Planets ..........................................................342
  25.1 Downloading comet elements ...............................................342
  25.2 Downloading minor planet elements .......................................344
  25.3 Quick insertion of a comet or minor planet ..............................348
  25.4 Creating a comet or minor planet object manually ..................349
  25.5 Updating elements ...........................................................350

26 Double Stars ............................................................................351
  26.1 Double star orbits ...............................................................351

27 Import and Export .....................................................................353
  27.1 Import ..................................................................................353
  27.2 Export ..................................................................................362
  27.3 Scripted solutions ...............................................................373

28 Scripting ..................................................................................374
  28.1 Editing and managing scripts ................................................374
  28.2 Downloading a user-contributed script ...................................377
  28.3 Deleting user-contributed scripts ..........................................379
  28.4 Running scripts ....................................................................380
  28.5 Using the Framework Reference ............................................380
  28.6 Script requirements ..............................................................382
  28.7 Uploading a user-contributed script .......................................383
  28.8 Event scripts ........................................................................384
  28.9 Printing scripts .....................................................................385
  28.10 User-defined field scripts ....................................................385
  28.11 Telescope mount scripts ........................................................386

29 Troubleshooting ......................................................................388
  29.1 Getting help ..........................................................................388
  29.2 Reporting bugs ......................................................................388
  29.3 Feature requests ....................................................................390
  29.4 Built-in tools ..........................................................................391

30 Glossary ..................................................................................395

31 Revision Notes .........................................................................402
  31.1 V2.0.1 ..................................................................................402
  31.2 V2.1 ......................................................................................403
  31.3 V2.2 ......................................................................................406
1 Introduction

Software applications for astronomy on the Macintosh are not nearly as abundant as applications on other platforms. Although there are several planetarium-style applications (Voyager, TheSky, Starry Night, Equinox, etc.) and a few others for telescope control (ScopeDriver), CCD camera operation (iCCD, Equinox, CCDSoft?) and a few minor utilities, there are some serious gaps. One of these is astronomical visual observation planning and logging. AstroPlanner attempts to fill this particular gap.

Although originally developed on and for the Macintosh, a Windows version is available which is functionally identical to the Macintosh version. The examples and descriptions in this manual are illustrated with screen shots from the Macintosh OS X version, but the Windows version behaves identically (except where noted).

1.1 What AstroPlanner does

AstroPlanner is a stand-alone application that allows the user to plan and execute an observing session. The user can enter objects to be viewed manually, import them from text files, look them up in several supplied catalogues, or use observing plans previously created by others. These objects can be both deep-sky and solar system objects (planets, sun, moon, asteroids, comets, etc.).

Once a list of objects has been created, they can be observed and log entries recorded for each of them. The application will also control a wide range of computerised Go To telescopes, in order to slew to selected objects. Several Digital Setting Circle (DSC) systems are also supported. Telescope control is optional, so AstroPlanner can be used to great effect even if you don’t have a computerised telescope mount.

The application computes the visibility of the objects for the current observing session, shows the sky for that time and can show the field-of-view for the current object as if it was being viewed through a virtual eyepiece, or the sensor of an imager.

Additionally, if you have a network connection, you can download high-resolution photographs of any part of the sky from the Digital Sky Survey (DSS and SDSS).

1.2 What AstroPlanner doesn’t do

AstroPlanner is not a full-blown planetarium application. It will not produce detailed sky maps or do the kinds of things an application such as Starry Night, Voyager or TheSky will do. It will also not do other specialised stuff like controlling CCD cameras or autoguiders, or astronomical image processing.

It is also not a "one button does it all" application, but rather an intricate set of tools that gives you full control over your observation planning. It’s not difficult to learn to use the application in its basic form. If you run through the quick start tutorial (Chapter 6 on page 22) you’ll get a good feel for the basics. Using the application to its full extent does have a learning curve, but you can assimilate new skills as and when you need them.

You don’t need to read this entire manual. We recommend you read through the first dozen chapters. The rest is reference material which you can use when you need to. If you are already familiar with previous versions of AstroPlanner, you might not need to crack the manual at all.

Feel free to experiment!
2 Installation

This chapter runs through the process of installing AstroPlanner V2 on your computer (whether you are a first-time user or upgrading from an older version).

If you are upgrading from AstroPlanner V1.x you should be aware that the installations are independent, so that you can run both V1 and V2 together without them interfering with each other.

2.1 Hardware and operating system requirements

AstroPlanner is a 32-bit application. It runs fine (or should run fine) on both 32- and 64-bit operating systems.

For both platforms a screen with an absolute minimum size (width and height) of 1024 x 600 pixels is required. If you are connecting to a telescope, you'll also need a built-in serial port, an USB-to-Serial converter (the Keyspan products are recommended), or a SkyFi/StarSeek WiFi-to-serial device.

2.1.1 Mac OS X

AstroPlanner V2 currently requires Mac OS X 10.4 (Tiger) or later. It is a Universal application and so will run natively on both Intel- and PowerPC-based Macs. You'll need at least 250MB of disk space, and for a complete installation with all optional catalogues, 2GB of disk space.

2.1.2 Windows

AstroPlanner V2 requires Windows XP or later. You'll need at least 250MB of disk space, and for a complete installation with all optional catalogues, 2GB of disk space.

2.2 Telescope mount compatibility

AstroPlanner V2.0 has built-in drivers for the following computerised telescopes and mounts:

<table>
<thead>
<tr>
<th>Astro-Physics GTO</th>
<th>Orion Intelliscope with COL</th>
</tr>
</thead>
<tbody>
<tr>
<td>Celestron NexStar</td>
<td>Orion SynScan GoTo</td>
</tr>
<tr>
<td>Celestron Ultima 2000</td>
<td>Sky Engineering Sky Commander</td>
</tr>
<tr>
<td>GTD Pulsar 2</td>
<td>Starmaster Sky Tracker</td>
</tr>
<tr>
<td>iOptron GOTONOVA</td>
<td>StellarCAT ServoCAT</td>
</tr>
<tr>
<td>Meade LX200 Classic</td>
<td>Takahashi Temma</td>
</tr>
<tr>
<td>Meade LX200 GPS/R/ACF (Autostar II)</td>
<td>Tasco Starguide</td>
</tr>
<tr>
<td>Meade MAX Mount</td>
<td>Vixen SkySensor</td>
</tr>
<tr>
<td>Meade RCX400</td>
<td>Vixen SkySensor 2000PC</td>
</tr>
<tr>
<td>Meade ETX, DS, LX, LXD, LS series (Autostar)</td>
<td>Vixen Star Book</td>
</tr>
<tr>
<td>Meade Magellan</td>
<td>Wildcard Innovations Argo Navis</td>
</tr>
</tbody>
</table>

These drivers are available for both Mac and Windows.

Additionally, basic ASCOM is supported for the Windows version, so that if your telescope mount isn't listed above, you can use the ASCOM driver of your choice (note that only telescopes can be driven via the ASCOM system, not focusers, etc.)
2.3 Macintosh application installation

2.3.1 On-line
Download the application from the download web page:

http://www.astroplanner.net/download.html

The application is in the form of a disk image file (.dmg extension).

![Figure 1: .dmg file in the Finder](image1)

If your browser does not mount and open the disk image for you, do so by double-clicking it in the Finder.

![Figure 2: Disk image opened](image2)

Drag the application file to your Applications folder (or drag in onto the Applications icon in the disk image window). There is no installer - just run the AstroPlanner application.

2.3.2 DVD-ROM or USB Flash Drive
If you ordered the DVD-ROM or USB Flash Drive with the application, then mount the disk in your computer, find the AstroPlanner disk image and proceed as for the on-line installation above.

Note that if your DVD-ROM or USB Flash Drive is outdated, you might want to download the application since it will guarantee the latest version. If you don't have the ability or desire to download the application, you can always order the latest version of the application and catalogues on DVD-ROM or USB Flash Drive for a modest fee.

2.4 Windows application installation

2.4.1 On-line
Download the application from the download web page:
The application is in the form of an installer application (InstallAstroPlanner.exe).

Double-click the installer to install the application and supporting files on your hard disk.

2.4.2 DVD-ROM or USB Flash Drive
If you ordered the DVD-ROM or USB Flash Drive with the application, then mount the disk in your computer. The installer should run automatically. If not, find the InstallAstroPlanner.exe on the disk and double-click it. Proceed as for the on-line installation above.

Note that if your DVD-ROM or USB Flash Drive is outdated, you might want to download the application since it will guarantee the latest version. If you don't have the ability or desire to download the application, you can always order the latest version of the application and catalogues on DVD-ROM or USB Flash Drive for a modest fee.

2.4.3 Uninstalling
When AstroPlanner is installed it also includes information required to uninstall AstroPlanner and an Uninstall application.

2.5 Installing catalogues
When you first run AstroPlanner it only installs a few minimal catalogues by default (Bright Star, Messier, NGC). You will need to install more catalogues to make full use of the application. You can elect to install these catalogues by downloading them from the on-line web site or, if you have a DVD-ROM or USB Flash Drive containing catalogues, by installing them directly from there.
If you are running AstroPlanner for the first time, the Setup Wizard will give you the opportunity to install catalogues (see Section 4.3 on page 9 for first time users, or Section 24.1 on page 329 for installing catalogues via the Setup Wizard at a later date).

Otherwise you use the Catalogue Manager (File > Catalogue Manager...) to manage your catalogues. This is detailed in Chapter 24 on page 329.
3  Unregistered users

If you are an unregistered user (i.e. you haven’t yet paid for a licence, or need to pay for an upgrade to the current version), then you will find that some features are limited or unavailable to you. While you are welcome to continue using AstroPlanner you will need to register in order to remove these restrictions and limitations.

3.1  Limitations

The most obvious limitation is that each time you run the AstroPlanner application, you will be asked for your licence number. This is irritating, but might help to give you the incentive to register.

![Unregistered user dialog](image)

Figure 5: Unregistered user dialog

The second major limitation is that you are limited to the three installed catalogues (Bright Star, Messier and NGC). You cannot download or install any other catalogues. Note that if you are a registered AstroPlanner V1 user, but have not paid the upgrade fee (if required), you are also restricted to using these three catalogues, even if you have others installed via AstroPlanner V1.

Other limitations:

- No external catalogues can be used (USNO A2.0, USNO B1.0, UCAC3, etc.).
- No SIMBAD searches can be performed.
- You can download user-contributed plans only if they contain objects from your installed catalogues (i.e. Messier and NGC objects only)
- You cannot upload user-contributed plans or user-contributed scripts.
- You cannot import objects from files, or by downloading them (e.g. comets, minor planets, tour files, etc.)

3.2  How to register

Go to the web site in your browser:

http://www.astroplanner.net/

Navigate to the Purchase page where you will be able to see what your options are.
4 First-time users

If you have never used AstroPlanner before, this is what will happen the first time you run the application after installing it.

4.1 V1 enquiry

You'll be asked if you have an AstroPlanner V1.x installation on your computer. Since you are a first-time user, click No.

![Figure 6: V1 installation enquiry](image)

If you do have a V1.x installation or did have one in the past, you might get the V1 upgrade dialog. This is covered in Chapter 5 on page 16.

4.2 Licence

You'll be asked to agree to the (fairly liberal) AstroPlanner application licence. If you agree, click Yes. If you don't, click No and the application immediately terminates.

![Figure 7: Licence agreement dialog](image)

For your convenience, the text of the agreement is given below:

```
NOTICE TO USER: THIS IS A CONTRACT. BY INDICATING YOUR ACCEPTANCE BELOW, YOU ACCEPT ALL THE TERMS AND CONDITIONS OF THIS AGREEMENT. IF YOU DO NOT AGREE WITH THE TERMS AND CONDITIONS OF THIS AGREEMENT, DESTROY THE SOFTWARE AND ALL ASSOCIATED DOCUMENTATION, OR IF YOU PAID FOR THE PRODUCT, RETURN IT FOR A REFUND.
```

- 7 -
This iLanga, Inc. ("iLanga") End User License Agreement (the "Agreement") accompanies software ("Software") and related explanatory written materials ("Documentation"). The term "Software" shall also include any upgrades, modified versions, updates, additions, and copies of the Software licensed to you by iLanga. iLanga grants to you a nonexclusive license to use the Software and Documentation, provided that you agree to the following:

**USE OF THE SOFTWARE**

You may:

a. Install and use the Software on a hard disk or other storage device of any number of computers personally owned and operated by you.

b. Make backup copies of the Software.

c. Make and use printed copies of any document files.

**COPYRIGHT**

The Software is owned by iLanga, and its structure, organization and code are the valuable trade secrets of iLanga. The Software is also protected by United States Copyright Law and International Treaty provisions. You must treat the Software just as you would any other copyrighted material, such as a book. You may not copy the Software or the Documentation, except as set forth in the "Use of the Software" section. Any copies that you are permitted to make pursuant to this Agreement must contain the same copyright and other proprietary notices that appear on or in the Software. You agree not to modify, adapt or translate the Software. You also agree not to reverse engineer, decompile, disassemble or otherwise attempt to discover the source code of the Software. Except as stated above, this Agreement does not grant you any intellectual property rights in the Software.

**TRANSFER**

You may not rent, lease, sublicense or lend the Software or Documentation. You may, however, transfer all your rights to use the Software to another person or legal entity provided (1) that you transfer this Agreement, the Software, including all copies, updates and prior versions and all copies of font software converted into other formats, and all Documentation to such person or entity, (2) that you retain no copies, including copies stored on a computer, and (3) that the receiving party accept the terms and conditions of this Agreement.

**LIMITED WARRANTY**

iLanga warrants to you that the Software will perform substantially in accordance with the Documentation for the ninety (90) day period following your receipt of the Software. If the Software does not perform substantially in accordance with the Documentation, the entire and exclusive liability and remedy shall be limited to either, at iLanga option, the replacement of the Software or the refund of the license fee (if any) you paid for the Software. ILANGA DOES NOT AND CANNOT WARRANT THE PERFORMANCE OR RESULTS YOU MAY OBTAIN BY USING THE SOFTWARE OR DOCUMENTATION. THE FOREGOING STATES THE SOLE AND EXCLUSIVE REMEDIES FOR ILANGA'S BREACH OF WARRANTY. EXCEPT FOR THE FOREGOING LIMITED WARRANTY, ILANGA AND ITS SUPPLIERS MAKE NO WARRANTIES, EXPRESS OR IMPLIED, AS TO NONINFRINGEMENT OF THIRD PARTY RIGHTS, MERCHANTABILITY, OR FITNESS FOR ANY PARTICULAR PURPOSE. Some states or jurisdictions do not allow the exclusion of implied warranties or limitations on how long an implied warranty may last, so the above limitations might not apply to you. To the extent permissible, any implied warranties are limited to ninety (90) days. This warranty gives you specific legal rights. You may have other rights which vary from state to state or jurisdiction to jurisdiction. For further warranty information, please contact iLanga.

**LIMITATION OF LIABILITY**

IN NO EVENT WILL ILANGA BE LIABLE TO YOU FOR ANY CONSEQUENTIAL, INCIDENTAL OR SPECIAL DAMAGES, INCLUDING ANY LOST PROFITS OR LOST SAVINGS OR DAMAGE TO EQUIPMENT, EVEN IF AN ILANGA REPRESENTATIVE HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES, OR FOR ANY CLAIM BY ANY THIRD PARTY. SOME STATES OR JURISDICTIONS DO NOT ALLOW THE EXCLUSION OR LIMITATION OF INCIDENTAL, CONSEQUENTIAL OR SPECIAL DAMAGES, SO THE ABOVE LIMITATIONS MAY NOT APPLY TO YOU.
4.3 Setup Wizard
As you are a first time user, the application needs you set up or customise various settings so that you can get going without further issue. To do this it presents a Setup Wizard dialog to lead you through the setup.

4.3.1 Licence information
The first thing you’ll need to do is enter your licence information in the fields given (unless you have not yet registered, in which case leave the fields blank).

If you’ve misplaced your licence information, you can get it sent to you via e-mail by entering your e-mail address in the field on the right and clicking the Retrieve button. If you have changed your e-mail address since you registered, then you will not get a reply. Please contact support with your new e-mail address, remembering to include your name and the old e-mail address:

    support@astroplanner.net

Once you have entered your licence info (or not), click the Next button.

![Setup Wizard](image)

Figure 8: Setup Wizard - licence information
4.3.2 Observing site data

AstroPlanner requires you to specify information about your observing site or sites. This information is used to figure out visibility at those sites. At least one site must be specified. You'll need to know the latitude and longitude where your site is situated, and its time zone.

However, if you live in the USA or Canada, AstroPlanner includes a database of place names and their geographic locations. Note that you don't have to be particularly accurate with defining the latitude or longitude. Even if you're out by a degree or two, it won't make much difference.

Enter the site information in the given fields. The world map will show where the site is (in case you give E/W or N/S mixed up), and will tell you if your GMT offset is acceptable. Click the Add this site button to add the site data to the resources.

Read the text on the right side of the dialog for additional instructions.

Note that you don't have to enter all of your possible observing sites at this time, since you can enter and edit them later. Just add your main site.

When you have finished, click the Next button to continue.

Figure 9: Setup Wizard - Observing Sites
4.3.3  **Telescope data**
AstroPlanner also expects you to enter information about any telescopes you plan to use. The information is used to construct charts showing the view through such a telescope, and what you are likely to see.

The dialog includes a comprehensive list of commercially-available telescopes. If your telescope or telescopes are in that list, select the entry and click the *Add* button.

You can also add the information manually, and use the *Add this telescope* button to add the new telescope entry.

Click the *Next* button when you’ve finished.

![Figure 10: Setup Wizard - Telescopes](image)

4.3.4  **Eyepiece data**
You can also enter information about any eyepieces you plan to use. The information is used in conjunction with the telescope information to construct charts showing the view through such a telescope/eyepiece combination, and what you are likely to see.

The dialog includes a comprehensive list of commercially-available eyepiece. If your eyepiece or eyepieces are in that list, select the entry and click the *Add* button.

You can also add the information manually, and use the *Add this eyepiece* button to add the new eyepiece entry.
Click the **Next** button when you’ve finished.

![Setup Wizard - Eyepieces](image1)

**Figure 11: Setup Wizard - Eyepieces**

### 4.3.5 Catalogues

When you enter the Catalogues part of the wizard, you’ll be asked if you want to install your catalogues from an AstroPlanner CD/DVD-ROM or USB Flash Drive, if you have such a thing. If you do, make sure the disk is inserted and ready to read. Then click **Yes**.

If you’d rather access the on-line inventory and download any catalogues you might need, click **No**.

![Catalogues from DVD-ROM or USB Flash Drive](image2)

**Figure 12: Catalogues from DVD-ROM or USB Flash Drive**
A list of available catalogues is presented (on the right side). Check the checkboxes next to the catalogues you wish to install (if you want all of them, click the **Select All** button).

If you’re not sure which ones you want, the application can choose some suitable ones for you. In this case, in the User Survey section on the left, check all the checkboxes next to equipment you own, and the kind of observing you plan to be doing. As you select options, suggested catalogues will be marked in green. You can use this as a guide, or just click the **Select All Suggested** button.

![Catalogue Manager](image)

**Figure 13: Setup Wizard - Catalogues**

When you've finished, click the **Next** button. You’ll be warned about the catalogues you selected.

![Catalogue warning](image)

**Figure 14: Catalogue warning**

### 4.3.6 Sample Plan Document

This page of the wizard lets you create a sample plan document if you wish. Type in a suitable file name, and select some suitable astronomical objects to populate it with.

The file will be created on your desktop, and opened for you.
When you’ve finished, click the **Next** button.

![Sample Plan Document](image)

**Figure 15: Setup Wizard - Sample Plan Document**

### 4.3.7 Completion

Finally, the actions you performed will be summarised on the Complete page.

To go ahead and create the resources, sample file, and/or install catalogues, click the **Finish** button. Otherwise click the **Cancel** button and all actions will be cancelled.

Note that you can call up the Setup Wizard at any time via the **File > Setup Wizard** menu item.

If you click **Finish** and there were catalogues selected to install, then the Catalogue manager window is opened, and you'll need to click the **Install** button to finish off the installation.
Figure 16: Setup Wizard - Completion
5  Upgrading from the previous version

If you have been running AstroPlanner V1.x on your computer, you can upgrade the files and databases from that version, and in some instances, share common data between the two versions.

Note that V1.x and V2 operate independently of each other, so you can continue using both versions if you need to. However, V2 uses a new format for most of the files and databases used in AstroPlanner V1. There is an upgrade path for these files, but no downgrade path. For this reason we strongly suggest that once you upgrade to V2 you abandon V1, otherwise you could get inconsistencies between files and databases.

5.1  First time after upgrade

The first time you run V2 after installing it (see Chapter 2 on page 2) it checks to see if you have a V1 installation present (by looking for its preferences). If it can't find such an installation, it will ask you if you have one.

![Figure 17: V1 installation enquiry](image)

If you answer Yes, then the application will ask you to navigate to the V1 folder (the folder containing the V1 application). Once there, or if the application finds the V1 preferences, a V1 to V2 upgrade dialog appears. This dialog lets you specify files and databases to be converted for use by V2.

These are:

- The Resources Database.
- The Catalogue Annotations Database (if applicable).
- The Observation Database (if this cannot be found you might have specified that it is saved in another location other than the standard one. Use the Find It... button to locate it if necessary.

Check those items that you want to convert.

Other files do not require conversion, since the V2 format is the same as the V1 format. You can elect to perform one of several actions to each in order to use them in V2:

- **Use the V1.x items from their current location.** Use this action if you want to share the data between V1 and V2. This might make sense if you are planning on using both the older version of the application as well as the new. Just make sure you don't remove or move the old installation.

- **COPY the items to the default V2 location.** Make a copy of the V1 files for use by V2. This uses a bit more disk space, but is a lot safer if you ever decide to do away with V1.
• **MOVE the items to the default V2 location.** If you are planning on using V2 and never again launching V1, then this is the option that uses the least disk space.

![V1 to V2 Conversion](image)

**Figure 18:** V1 to V2 conversion dialog

When you click **OK** the files will get converted, copied and or moved. Note that if you are running on a Macintosh with Mac OS X 10.7 (Lion) or later, additional steps are required (see Section 5.3.1 on page 18).

Note for those who might notice: the new file format is significantly more compact, robust, and efficient. Don’t worry if your file sizes shrink by 50% or more, the data are all there.

If you need to do this operation again in the future, see Section 29.4.4 on page 394.

### 5.2 Opening V1.x plan documents

Any V1 plan document will also need to be converted for V2 use. When you open a V1-formatted plan document using **File > Open...** the following dialog appears.

![Opening a V1 plan document](image)

**Figure 19:** Opening a V1 plan document

- 17 -
You can choose to convert the plan document (the original V1 file is not disturbed). You can also elect to transfer any local observations from the V1 plan document into the V2 observation database (if the observations are already in the database they will be ignored).

There is also an option to convert any other V1 plan documents in the same folder as the one you're opening.

The conversion is then done, creating a new file with the same name as the original, prefixed with "V2".

![Conversion warning](image)

**Figure 20: Conversion warning**

### 5.3 Special issues for Mac OS X Lion users

It is not possible to directly convert V1 files to V2 in Mac OS X 10.7 (Lion) or later, for technical reasons\(^1\). Hence Lion users have a bit more work to do to convert V1 documents.

#### 5.3.1 Converting V1 databases

When you attempt to convert V1 databases the first time you run (see Section 5.1 on page 16), you receive this warning:

![Mac OS X Lion Warning](image)

**Figure 21: Mac OS X Lion Warning**

If you choose to go ahead, the following dialog asks you for your email address:

![Conversion confirmation](image)

**Figure 22: Conversion confirmation**

---

1. For the curious, read this: http://blog.astroplanner.net/?p=153
The files to be converted are uploaded to the AstroPlanner web site. The following message is displayed:

![Conversion warning](image)

**Figure 23: Conversion warning**

After a suitable amount of time (anything from minutes to hours) you will receive an e-mail message notifying you that the documents were converted and are ready. If you didn't supply an e-mail address, you won't get notified.

![Conversion e-mail message](image)

**Figure 24: Conversion e-mail message**

In order to use the converted databases, quit and restart AstroPlanner. Every time you restart AstroPlanner, it checks to see if any conversions are pending and if so it checks their status on-line (if there's an Internet connection available). If the files are ready, it downloads them and issues the following message:

![Update database message](image)

**Figure 25: Update database message**

Assuming you say *Yes*, the databases are then copied into place and you are requested to quit and restart again.

![Restart message](image)

**Figure 26: Restart message**
5.3.2 Converting V1 plan documents
When you attempt to open a V1 plan document (via, say, File > Open...) you will receive this warning:

![Lion conversion warning](image)

Figure 27: Lion conversion warning
You then get the "usual" conversion confirmation dialog, with the addition of an (optional) e-mail address.

![Lion Plan Conversion dialog](image)

Figure 28: Lion Plan Conversion dialog
The file or files to be converted are uploaded to the AstroPlanner web site. You receive a warning (in this case no e-mail address was specified).

![Warning](image)

Figure 29: Warning (with no e-mail address specified)
Every time you restart AstroPlanner, it checks to see if any conversions are pending and if so it checks their status on-line (if there's an Internet connection available). If the files are ready, it downloads them and issues the following message:
Figure 30: Converted file destination dialog
6 Quick start tutorial

The aim of this chapter is to lead you through some typical tasks you would use AstroPlanner for. By the end of this chapter you should be familiar enough with the application to use it without assistance, and be ready to start experimenting and exploring. We suggest you follow along and duplicate what is described here yourself, as it will aid in your familiarisation.

It's assumed that you have the application open, and that you've completed the installation tasks.

We're going to do the following:

- Set up an observing plan for an article in Sky & Telescope magazine, which just happens to be available for download.
- Set up another observing plan for another Sky & Telescope article that is not available.
- Use the Plan Creation Wizard and let AstroPlanner set up a custom plan for you.

Once we've done that we'll pick one of these plans and do some observing.

6.1 Creating a new plan

6.1.1 Setting up a plan that someone else has already done for you

For illustrative purposes, let’s say we just read the article on pages 67 through 70 of the September 2011 issue of Sky & Telescope magazine, entitled *In Praise of the Great Dark North*, by David Rodger. This article talks about a selection of interesting objects in the northern sky. We'd like to set up an observing plan to look at these objects. Perhaps we’ll get lucky and someone has already done the work for you and is willing to share. Let’s check the on-line user-contributed plan depository.

![Image of user-contributed plans](image_url)

Figure 31: User-contributed plans
Use File > User-Contributed Plans > Download... (assuming you are currently connected to the Internet). The window shown in Figure 31 appears. You can look for the item manually in the hierarchical list (you'll find it under By Category > Magazines > Sky and Telescope > Other), or even quicker by typing Great Dark North into the Find field (centre right) and clicking Find.

![Figure 32: Using the Find feature](image)

Select the GreatDarkNorth.txt entry by clicking the checkbox next to it and then clicking the Download button. The plan is downloaded and opened. Close the user-contributed plans window and, if you so choose, save the GreatDarkNorth plan on your hard disk.

![Figure 33: GreatDarkNorth observing plan](image)

### 6.1.2 Setting up a plan manually

The next plan we are going to set up is for an article in the same issue of Sky & Telescope magazine: *Deep Sky Wonders: The Berkeley Clusters* by Sue French (pages 56 to 58, September 2011 issue). This time we won’t assume someone else already uploaded the plan for our convenience, but we’ll enter the objects manually.

Note that the Berkeley Catalogue is available (for registered users) which makes this a lot easier. However, for the sake of this exercise, we’ll assume the Berkeley Catalogue has not been installed.
On page 57, French conveniently gives us a table containing details about the objects she refers to in the article. Here is a summary:

<table>
<thead>
<tr>
<th>Object ID</th>
<th>Magnitude</th>
<th>Size</th>
<th>RA</th>
<th>Dec</th>
</tr>
</thead>
<tbody>
<tr>
<td>NGC 6749</td>
<td>12.4</td>
<td>4'</td>
<td>19h 05.3m</td>
<td>+01° 54'</td>
</tr>
<tr>
<td>NGC 6791</td>
<td>9.5</td>
<td>10'</td>
<td>19h 20.9m</td>
<td>+37° 46'</td>
</tr>
<tr>
<td>IC 1310</td>
<td>~10</td>
<td>4'</td>
<td>20h 10.0m</td>
<td>+34° 58'</td>
</tr>
<tr>
<td>Berk 82</td>
<td>~9</td>
<td>4'</td>
<td>19h 11.3m</td>
<td>+13° 07'</td>
</tr>
<tr>
<td>Messier 29</td>
<td>6.6</td>
<td>10'</td>
<td>20h 24.1m</td>
<td>+38° 30'</td>
</tr>
<tr>
<td>Berk 86</td>
<td>7.9</td>
<td>7'</td>
<td>20h 20.2m</td>
<td>+38° 41'</td>
</tr>
<tr>
<td>Berk 87</td>
<td>~7</td>
<td>10'</td>
<td>20h 21.6m</td>
<td>+37° 24'</td>
</tr>
</tbody>
</table>

We're now going to enter these objects manually.

Create a new plan document (*File > New*).

Create a new object by clicking the + button at the bottom left of the object list. This reveals the New Object dialog. Type in the ID of the first object, NGC 6749 (you can skip the space if you like). Hit the Return/Enter key or click the **Best** button. NGC 6749 is found in the catalogues and added to the plan.

![New Object dialog](image)

**Figure 34:** New object dialog

Repeat the above procedure for NGC 6791, and IC 1310. The next object is Berk 82. This object can be found in the Berkeley Catalogue, but as mentioned above, we'll assume it isn't installed. Click the + button as before, but this time just click the **Empty** button. This creates an empty entry. To edit this entry you will need to reveal the editing fields by clicking on the *Show editing fields* button (the small button, fourth from the left underneath the object list).

Into the **ID** field type "Berk 82".

Into the **Right Ascension** fields type "19" and "11.3".

---

1. Note that you'll need the IC Catalogue installed. Unregistered users are out of luck, and should proceed as for Berk 82.
Into the **Declination** fields type "13" and "7".

Into the **Magnitude** field type "9".

Into the **Size** field type "4".

Use the popup to the right of the **Type** field to choose "Open" as the object type.

---

**Figure 35: Entering Berk 82 manually**

We're going to demonstrate another way to enter Messier 29 (M29). From the **Show Catalogue** pop-up button under the list of objects, choose to show the Messier Catalogue.
Select the entry for M29 and click the **Add Selected** button (or drag the object from the window onto the object list in your plan).

Add the final two objects (Berk 86 and Berk 87) using one the above techniques.

Save the plan document to hard disk if you wish.

### 6.1.3 Letting the Plan Creation Wizard create a plan for you

The Plan Creation Wizard creates a custom observing plan just for you.

Start the wizard using the **File > Plan Creation Wizard...** menu command.
Use the Next button to move through the stages required to build a plan. At any stage you can also use the Previous button to go back and change an option if you need to do so.

The second panel (Who) lets you specify the observer (so we can take into account such aspects as age and visual acuity\(^1\)). If you haven’t created an Observer resource just use the "Unknown" setting\(^2\).

We also specify the level of difficulty for the objects in the resulting observing plan. You can specify five levels, from Easy (probably observable in poor skies with minimal equipment and experience) through Difficult (probably requiring a lot of experience and large aperture telescopes).

The third panel (Where and When) specifies where you will be observing from (your observing site) and when you plan to do the observing. These settings are used to determine what objects will be visible for you. It’s not reasonable to choose objects that either never rise above the horizon at your observing site, or objects that never rise during the observing period, but might be visible at other times of the year.

You select the Observing site resource\(^2\). You then need to specify the dates/times you plan to do your observing (make sure the Restrict to option is set to Date/time). In our case, we are doing our observing at the Winter Star Party site in Florida, during Winter (go figure), and we’ll plan on doing our observing between the start of nautical twilight and 2am (when we collapse into our sleeping bag).

\[\text{\begin{figure}
\centering
\includegraphics[width=\textwidth]{plan_creation_wizard.png}
\caption{Plan Creation Wizard - Who}
\end{figure}}\]

---

1. In the current version of AstroPlanner, these aspects are not taken into account, so any observer has the same weight as any other observer.

2. If you want to or need to set up such a resource you can skip ahead to Section 6.2 on page 30. However, you will need to cancel from this dialog first.
Figure 39: Plan Creation Wizard - Where & When

The next panel (How) lets you choose what instruments (telescopes or binoculars) you intend to be using. Check the appropriate entries².

Figure 40: Plan Creation Wizard - How

The next panel (What) specifies the kinds of objects you want to observe and how many. Select one or more object types by checking the appropriate checkboxes. Don't worry about the list of catalogues - that's for more advanced and specialised work.

Select the maximum number of objects you'd like in the observing plan. In this case we'll choose a maximum of 20 (the actual number found might be fewer).
The final panel (Complete) lets you select whether to create a new, untitled plan document for your objects, or to add them to a currently-open plan document. We’ll choose a new document.

When you click the Finish button a new document is created with (in this case) 20 objects in it. You can save the plan document with whatever name you see fit to give it.
Figure 43: Plan Creation Wizard - The resulting observing plan

For more information on the Plan Creation Wizard see Section 11.3 on page 90.

6.2 Setting up resources

When you first used AstroPlanner (assuming you didn’t upgrade from an earlier version, or cancel from the Setup Wizard), the Setup Wizard asked you to enter some basic information about your observing site or sites, telescopes and eyepieces. All of these entities are called "resources" (see Section 8.5 on page 46). You will occasionally need to edit these resources in order to add, modify or delete them. We’ll do this to add a telescope with a computerised mount for use later in this chapter (don’t worry if you don’t have an actual computerised mount - we’ll fake it).

To edit resources, use the Edit > Resources... menu command.
6.2.1 Sites
The window contains several tabs, each one containing a different type of resource. The first tab (Sites) contains your observing sites. You should have at least one entry here. If not, click the + button under the list on the left to create a new one. Make sure you enter the latitude, longitude and Offset from GMT values correctly (other settings are less critical).

6.2.2 Telescopes
Select the second tab (Telescopes). For this exercise you should have at least one telescope defined. You should also set up a telescope with a computerised mount, so that you can experiment with controlling that telescope (see Section 6.4 on page 38). Even if you don't have such a telescope, AstroPlanner includes a telescope emulator that lets you control an internal software telescope that looks to the application like a real telescope.

We are going to create such a "fake" telescope:

- Click the + button under the list of telescopes to create a new entry. Alternatively, you can click the Select from List... button and choose from a list of commercially-available telescopes.
- Change the Resource Name to "Experimental" (or choose your own name).
- Change the Computerised Mount via the popup menu to "AstroPlanner: Emulated Go To".
- Leave the other fields as they are.
Figure 45: Telescope resources

If you have a physical telescope with a supported computerised mount (e.g. A Meade Autostar- or Celestron NexStar-controlled telescope), then you can set this up quite easily:

- Change the **Computerised Mount** via the popup menu to the particular mount you have (e.g. "Meade: ETX series").
- Click the **Edit...** button to the right of the Computerised Mount Popup. This opens a dialog to allow you to edit various settings of your telescope mount.
- Select the **Serial port** that your telescope will connect to (top left of the edit dialog).
- If available to you, also set the **Bit Rate** (top right of the dialog) to match your mount’s bit rate setting. If this is disabled, it means you have no choice, and you can ignore it.
- Leave the other settings as they are, and click **OK**.
6.2.3 Eyepieces

Similarly, select the third tab (Eyepieces) and enter at least one eyepiece resource. Make sure, for each eyepiece, you enter the focal length and the apparent field-of-view correctly. Alternatively, you can click the Select from List... button and choose from a list of commercially-available eyepieces.

6.3 Visualising objects

We will use the plan we set up manually (see Section 6.1.2 on page 23), but you can use any plan you like, as long as it has a few objects in it. What we would like to do is answer the questions below regarding the actual object in the night sky. This is what observation planning is all about.

In the open plan document set the Site popup (top right) to your preferred observing site.

6.3.1 Is an object currently visible in the sky?

Right now (daytime or nighttime), can I see the object? This is easily seen by looking at the Visibility (Vis) column of the object list. If the Vis column entry for an object is blank (or contains "Horz"), it means that the object is not currently visible in the sky and is either below the horizon or is never

1. If it's daytime, this question is theoretical, unless the object is the sun or moon.

2. Hidden by the site horizon (e.g. a wall, trees, a house, etc.)
visible at the latitude of your site. If the Vis column is "Yes" then the object is currently visible. In Figure 47, NGC6749 and Berk 82 are currently not visible, and the others are all visible.

Additionally, you can look at the Rise Time (Rise) and Set Time (Set) columns to see when the objects will be visible. If Rise is "Never" then the object is never visible at the latitude of your selected observing site. If Rise is "Circum" then the object is circumpolar (i.e. is always visible at your observing site).

### Table of Visibility

<table>
<thead>
<tr>
<th>ID</th>
<th>Images</th>
<th>Name</th>
<th>Type</th>
<th>RA</th>
<th>Dec</th>
<th>Azimuth</th>
<th>Altitude</th>
<th>Rise</th>
<th>Transit</th>
<th>Set</th>
<th>Vis</th>
<th>Obs</th>
</tr>
</thead>
<tbody>
<tr>
<td>NGC6749</td>
<td>NGC6749</td>
<td>Globular</td>
<td></td>
<td>15h 05m 06s</td>
<td>+01°47.0</td>
<td>69°</td>
<td>-16°</td>
<td>4:34 PM</td>
<td>10:45 PM</td>
<td>4:56 AM</td>
<td></td>
<td></td>
</tr>
<tr>
<td>NGC6791</td>
<td>NGC6791</td>
<td>Open</td>
<td></td>
<td>19h 20m 42s</td>
<td>+37°51.0</td>
<td>44°</td>
<td>11°</td>
<td>1:03 PM</td>
<td>11:01 PM</td>
<td>8:59 AM</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>IC1310</td>
<td>IC1310</td>
<td>Open</td>
<td></td>
<td>20h 10m 00s</td>
<td>+34°58.0</td>
<td>38°</td>
<td>3°</td>
<td>2:26 PM</td>
<td>11:59 PM</td>
<td>9:14 AM</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>Berk 82</td>
<td>Berk 82</td>
<td>Open</td>
<td></td>
<td>18h 11m 16s</td>
<td>+13°07.0</td>
<td>41°</td>
<td>-8°</td>
<td>3:49 PM</td>
<td>10:51 PM</td>
<td>5:53 AM</td>
<td></td>
<td></td>
</tr>
<tr>
<td>M29</td>
<td>M29</td>
<td>Open</td>
<td></td>
<td>20h 23m 57s</td>
<td>+38°30.5</td>
<td>33°</td>
<td>5°</td>
<td>1:56 PM</td>
<td>12:04 AM</td>
<td>10:12 AM</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>Berk86</td>
<td>Berk86</td>
<td>Open</td>
<td></td>
<td>20h 20m 24s</td>
<td>+34°42.0</td>
<td>34°</td>
<td>5°</td>
<td>1:50 PM</td>
<td>12:06 AM</td>
<td>10:11 AM</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>Berk87</td>
<td>Berk87</td>
<td>Open</td>
<td></td>
<td>20h 21m 42s</td>
<td>+37°22.0</td>
<td>34°</td>
<td>4°</td>
<td>2:10 PM</td>
<td>12:02 AM</td>
<td>9:53 AM</td>
<td>Yes</td>
<td></td>
</tr>
</tbody>
</table>

**Figure 47: Visibility of objects**

### 6.3.2 Will an object be visible when I view the sky at a particular date/time in the future?

The above visibility test is for the current time. You can also check to see whether the object is going to be visible at another time (e.g. next Saturday at 10pm). To do this we use the Fix Date feature of AstroPlanner. This allows you to freeze the Date and Time at specific values and look at the visibility.

The Fix Date feature looks different depending on how wide your plan document window is. If your window is fairly small (e.g. you’re using a netbook computer with a small screen) then you will see a Fix Date button and a checkbox at the top right of the plan document window (next to the Site pop-up) as shown in the left part of Figure 48. If you click the button, a Fixed Date/Time floating window appears. You choose the desired date and time using the controls on the window and click the Apply button. The visibility settings will all change to reflect the new date/time. You can go back to current real time by unchecking the checkbox next to the Fix Date button.

If your window is wide enough, the Fix Date button vanishes and is replaced by a Date/Time panel (see the right part of Figure 48). Just change the date or time controls to fix the date. Going back to real time occurs when you uncheck the Fix date checkbox.

**Figure 48: Fixed date/time**
6.3.3 Where in the sky is the object?
This is where the Sky tab comes in. The tab contains an all-sky chart showing the whole sky as it appears at the selected Site at the current or selected date and time. If you had selected the object of interest in the object list before switching to this tab, the object will be shown on the chart if it's above the horizon (in the figure below, Berk 87 is selected).

Feel free to twiddle with the various Display Options on the right of the chart. You can also use the slider under the Display Options to see the chart at other times of the day/night.

Figure 49: Sky tab

6.3.4 What am I going to see through my telescope?
The next question is figuring out what you are going to see when you look through your telescope with a particular eyepiece. This is done by selecting the object in question in the object list and switching to the Field of View tab.

For our example here, we will select M29 in the objects list and then select the Field of View tab.

This tab displays a chart that attempts to preview what you will see through a telescope. On the right side are various settings to help you with that. Most importantly, at the top are settings that let you select the telescope and eyepiece you are going to use.

In our case (see Figure 50), we are going to use a telescope called "Orion ED 80 APO" together with a "Panoptic 35mm" eyepiece. Once those are selected, the application computes the actual field diameter (in this case, 1.19°) and draws a chart centred on M29 of that computed diameter. You will also want to see what stars are going to appear in the field of view. You do that by selecting one (or
more) stellar catalogues in the list at the bottom right. If a catalogue’s checkbox is checked then any objects in that catalogue that also appear in the field of view will be charted (if they are within the Magnitude Limits defined).

![Field of View tab](image)

In the field of view chart, non-stellar objects are displayed using symbols, which means the field of view chart is only a representation of what you will see.

### 6.3.5 What does the object actually look like?

Figuring out what an object actually looks like through a telescope is not an easy problem to solve. What can be done though, is to look at a photographic image of the object and use that, understanding the fact that in reality it will typically appear much dimmer when viewed visually through a telescope.

AstroPlanner includes the ability to download and save images of the objects you want to observe. These images come from photographic sky surveys (in particular the Digital Sky Survey (DSS)\(^1\) and the Sloan Digital Sky Survey (SDSS)). We will download images for the objects in our plan. Proceed as follows (noting that this will require an Internet connection):

- Select **Images > Download Images...** from the main menu.
- In the Images window (Figure 51) select to download for all the objects (7 in this case).

---

1. Also known as POSS (Palomar Observatory Sky Survey)
• Select the checkbox to **Select image size from object**, and make the image size 200% of object size.

• Select the **POSS 1st Gen** data source by checking its checkbox.

• Click the **Start Download** button.

The download then proceeds. The **Status** tab shows the progress.

Once the download has completed (or before if you like), close the download window and go back to the **Objects** tab of your plan document. You’ll see that the **Images** column of the list now has a "D" badge in it. This signifies that the object has one or more associated images. If you select such an object then the image of that object will appear on the right of the object list, as shown in Figure 53.

If you then switch to the **Field of View** tab, the image will be displayed as part of the chart, as shown in Figure 54.
6.4 Using a computerised telescope

For this demonstration we are going to use our "Experimental" telescope resource that we set up to use an emulated go to mount. You can use a real computerised mount if you wish, the process is identical (if somewhat noisier in the case of a real mount).

In the plan document window, choose your telescope resource in the telescope panel at the top left.
Check the **Connect to telescope** checkbox. The application then attempts to connect to the telescope mount, after which the checkbox caption changes to **Connected to telescope**, with the telescope firmware version number if applicable.

![Telescope panel before and after connecting](image)

**Figure 55:** Telescope panel before and after connecting

In the case of the emulated mount, a small floating window appears showing the current status of the emulated telescope.

![Emulated telescope floating window](image)

**Figure 56:** Emulated telescope floating window

At the top of the plan document window the "LED" displays will now include the Telescope RA, Dec, Altitude and Azimuth (assuming there's enough width to display them).

Now select an object in the object list. If it is currently visible the **Slew to Object** button next to the Telescope popup will be enabled. Click the button to slew the telescope to the selected object.

![Telescope slewing to selected object](image)

**Figure 57:** Telescope slewing to selected object
6.5 Making observations and logging them

So now we have an idea on how to construct an observing plan, how to get a heads-up on what we're likely to see, and how to control our telescope. Now we can observe. This section is a brief tutorial on how to log observations.

To log an observation:

- Select the object you are observing in the list in the Objects tab of the plan document window.
- Click the New Observation button under the list. The Observation Date/Time dialog is opened.
- If you are logging observations at your telescope, you click the Now button, otherwise enter the date and time of the observation. The graphic at the top shows the current time of day/night and the altitude of the object (red crosses). Click OK.

![Observation Date/Time](image)

Figure 58: Observation date/time dialog

- The observation is added to list of observations for this object. It's now up to you to fill in the applicable fields for the observing session (this observation is the first observation logged for this session). You should also log a description of what you saw.

---

1. This is a short cut for switching to the Observations tab and clicking the + button under the list of observations.
6.6 Printing reports

AstroPlanner includes features for printing observing forms (forms with blank spaces that you can fill in by hand), observing reports (a printed list of observations), and finder charts (for a particular object: charts at various resolutions that help you to find the object in the field).

We will continue using the small plan we devised earlier. Note that you can see the printed output as an on-screen preview without having to print it out on dead trees.

We'll look only at printing observing forms. The other types of printed reports are very similar.

6.6.1 Observing forms

Here's how to print observing forms for the objects in your plan:

- Go to the Objects tab.
- Use the File > Print... menu command.
- The Print Objects dialog is displayed. Choose Observing Forms from the Task popup.
- Select the informational fields you'd like printed out for each object (under Object fields), and the fields you'd like to print out as a blank template (Session and Observation fields).
- There are a number of Options you can play with. For this exercise we left the default settings, but added the Object images setting under Images and Charts. We also selected the Sketching Templates option. See Figure 60.
- Click the Preview... button. The first time you use this in a run the Printer Setup dialog will be displayed so that you can specify paper size, portrait vs. landscape, etc.
- The preview window is then generated (Figure 61). If you're happy with the report format then use the Print... button to print it out, otherwise close the preview window and try again.
Figure 60: Print dialog for observing forms
Figure 61: Print preview for observing forms
7 How to get help

AstroPlanner is a very rich application and it takes some time and effort to get it to do your bidding. There are several ways to get help. Remember: no question is too dumb.

7.1 User Manual
This manual is the "definitive" source of assistance for the application. Use the PDF search features to find what you want within the manual, or just peruse the Table of Contents. If a feature isn't discussed in this manual, it's a bug! (please contact the vendor - see below)

There's a troubleshooting chapter in this manual if you are having problems that you think are abnormal (e.g. the application is crashing, won't connect to your telescope, etc.).

7.2 User group
There's a Yahoo group dedicated to AstroPlanner:

http://tech.groups.yahoo.com/group/astroplanner/

There are a lot of friendly people there, including the author of the application, who are ready to answer your questions. There's also an archive of posts, and searching it might throw light on your issue.

7.3 Vendor
Feel free to send your questions, requests, etc. to technical support:

support@astroplanner.net

Although we need sleep too, we'll get back to you as soon as we can.

7.4 FAQ
There's a FAQ (Frequently Asked Questions) page at:

http://www.astroplanner.net/faq.html

This will be updated as questions come in that are considered of interest to more than just the asker of the question.

7.5 Blog
Although it can't really be classified as a "help resource", there's a blog written by the AstroPlanner author that might occasionally offer some insight into the devious mind behind the product:

http://blog.astroplanner.net/

1. Some might use the phrases "overly-complex", "feature-laden", or "learning-curve challenged".